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1 Introduction
Overview of Keysight E6959A ECU Compliance Test Application

Testing an ECU PHY’s transmitter characteristics is accomplished using various test modes defined 
in the 100BASE-T1 specification. See “Reference Documents” on page 36. The ECU PHY’s 
transmitter would be referred to as the DUT or Device Under Test for the rest of the document.

Keysight’s E6959A Automotive Ethernet TC8 ECU Compliance Test Application (provided as a 
software option to the E6961A Automotive Ethernet Solution) provides the means for testing and 
validating transmitted frequency, distortion, jitter and droop, as well as MDI Return Loss, Mode 
conversion and Common Mode Emission. The test modes change only the data symbols provided 
to the transmitter circuitry and do not alter the electrical and jitter characteristics of the transmitter 
and receiver from those of normal operation.

Using the Keysight E6959A Automotive Ethernet TC8 ECU Compliance Test Application along with 
the N5395C Ethernet Test Fixture or equivalent fixture greatly simplifies compliance testing. The 
software automatically configures all the required test equipment as well as reducing the overall 
test time.

Test Test Mode/Configuration Test Classification

Transmitter Output Droop Test Mode 1 Optional1

1 The test could be executed but not required for an official qualification pass/fail criterion.

Transmitter Timing Jitter Test Mode 2/ Master Mandatory2

2 The test is required and must be evaluated according to the specified pass/fail criterion.

Transmit Clock Frequency Test Mode 2 Mandatory

Power Spectral Density Test Mode 5 Optional

MDI Return Loss Slave Mode. 
No test mode transmitted

Mandatory

MDI Mode Conversion Slave Mode. 
No test mode transmitted

Mandatory

MDI Common Mode Emission Test Mode 5 Optional

Transmitter Distortion Test Mode 4 Optional
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Introduction 1
The E6959A Software:

• Lets you select individual or multiple test to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for averaging in each test.

• Provides detailed information of each test that has been run. The result of maximum 64 worst 
trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run. This report includes pass/fail 
limits, margin analysis, and screen captures.

Installing the Compliance Test Application

1 Make sure you have the minimum version of Infiniium oscilloscope software (06.30.00701) by 
choosing Help > About Infiniium... from the main menu. (You can also refer to the software release 
notes for this information.)

2 To obtain the E6959A Compliance Test Application, go to Keysight website: 
http://www.keysight.com/find/E6959A.

3 Click the Trials & Licenses tab.

4 Click the Details & Download button.

5 Read and verify the Prerequisites and installation information. Follow the instructions to 
download and install the application software. Click the red Download button.

Installing the License Key

1 Request a license code from Keysight by following the instructions on the Entitlement 
Certificate. You will need the oscilloscope's “Option ID Number”, which you can find in the 
Help > About Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Utilities > License Manager > Legacy 
Licenses... Depending on the license acquired, select either Local License or Server License.

3 In the Install Option License dialog box, enter your license code and click Install License.

Additional information is required for server based licensing. Please refer to your entitlement 
certificate for more details.

4 Click OK in the dialog box that tells you to restart the Infiniium oscilloscope application software 
to complete the license installation.

5 Click Close to close the Install Option License dialog box.

6 Choose File > Exit.

7 Restart the Infiniium oscilloscope application software to complete the license installation.

You can also install the license using Keysight License Manager. For detailed instructions, refer to 
the online help for the Keysight License Manager.
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 7
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1 Introduction
Preparing to Take Measurements

Before running the E6959A automated compliance tests, you should calibrate the oscilloscope and 
probe. After calibrating the oscilloscope and probe, you are ready to start the Compliance Test 
Application and perform the measurements.

Calibrate the Oscilloscope

For information on performing the internal diagnostic and calibration cycle for your Keysight 
Infiniium oscilloscope, refer to the “User Calibration” topic in your oscilloscope’s online help.

Probe Calibration

Before performing the automated tests, you should calibrate the probes. Calibration of the 
solder-in probe heads consists of a vertical calibration and a skew calibration. The vertical 
calibration should be performed before the skew calibration. Both calibrations should be 
performed for best probe measurement performance.

For information on performing probe vertical and skew calibration in your Keysight Infiniium 
oscilloscope, refer to the “DC Attenuation/Offset Calibration” and “Skew Calibration” topics in your 
oscilloscope’s online help.

For more information on calibration/deskew procedures for your particular probe, refer to the 
probe’s user guide in the Keysight Probe Resource Center.

If the ambient temperature changes more than 5 °C from the calibration 
temperature, internal calibration should be performed again. The delta between 
the calibration temperature and the present operating temperature is shown in 
the Utilities > Calibration menu.

If you switch cables between channels or other oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
8 Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation



Introduction 1
General Test Setup

Transmitter Output Droop, Transmitter Timing Jitter, Transmit Clock Frequency, Power Spectral 
Density and MDI Common Mode Emission require only the Infiniium oscilloscope and the device to 
be tested (Device Under Test or DUT). The test setup is described below. The signal supplied to the 
oscilloscope can either be a differential signal, or single ended signal. 

Differential signaling type refers to connecting the differential automotive pair to the oscilloscope 
using only SMA cables. Refer to Figure 1 for more details.

Single ended signaling type here refers to connecting the differential automotive pair to the 
oscilloscope using a single differential probe. Refer to Figure 2 for more details. The only variation 
to the single ended signaling type would be the Common Mode Emission test that requires a 
specific fixture as well as the Power Spectral Density test that requires a balun.

Any variation from the above definition of signaling type is not recommended. The type of 
connection accepted can be selected in the Set Up tab of the test application.

Transmitter Distortion requires the N5395C Ethernet Test Fixture and an Arbitrary Waveform 
Generator (AWG). Refer to “Transmitter Distortion Test” on page 30 for specific setup details. 

MDI Return Loss and MDI Mode Conversion requires a VNA to execute. Also the DUT has to be in 
Slave mode with no test mode being transmitted. Refer to “MDI Return Loss Test” on page 24 and 
“MDI Mode Conversion Test” on page 26.

Power Spectral Density can also use the N9010B Signal Analyzer. Refer to “Transmitter Power 
Spectral Density (PSD) Test” on page 22.

Similarly, MDI Common Mode Emission can also use the N9010B Signal Analyzer. Refer to “MDI 
Common Mode Emission Test” on page 28.

Differential Connection to Oscilloscope

Two SMA cables are needed to directly connect the output of the transmitter (ECU) to the 
oscilloscope. The specific oscilloscope channel used can be selected in the Configure tab of the 
application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.

Figure 1 Connection to the Oscilloscope Using a Pair of SMA Cables
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 9



1 Introduction
Single-ended Connection to Oscilloscope

A differential probe is used to connect the output of the transmitter (ECU) to the oscilloscope. The 
specific oscilloscope channel used can be selected in the Configure tab of the application.

An optional TX_TCLK may be supplied to the oscilloscope to run the tests.

Connection Using the N5395C Ethernet Transmitter Test Fixture

Alternately, you can use Section 1 of the N5395C Ethernet 10/100/1G Transmitter Electrical Test 
Fixture to make connections to the Transmitter under test. This connection is only valid if the DUT 
has an RJ45 connector. The SMA connections shown in Figure 3 are for wire pair A (DA+ and DA–) 
in the RJ45 cable. To test to wire pair B, C, or D, connect the oscilloscope SMA cables to the 
appropriate Evaluation Board SMA connectors.

Figure 2 Connection to the Oscilloscope using a Differential Probe

Figure 3 General Test Setup using the N5395C Evaluation Board
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Introduction 1
Connection Using the Automotive Ethernet SMA Adapter

Another option would be to use the Keysight Automotive Ethernet SMA Adapter to make 
connections to the DUT. This adapter is an alternative to using Section 1 of the N5395C Ethernet 
10/100/1G Transmitter Electrical Test Fixture shown in Figure 3 above.

This adapter is designed as outlined in OPEN Alliance Automotive Ethernet ECU Test Specification, 
v2.0, Section 2.2.2, Test OABR_PMA_TX_05 and OABR_PMA_TX_06. It is designed in line with the 
definitions of IEEE 100BASE-T1 Definitions for Communication Channel, Version 1.0. 

If you need a similar fixture, please contact your Keysight sales representative for more details.

For all tests, use the software supplied with your transmitter PHY to control the 
Device Under Test.

Figure 4 Design of Recommended Test Fixture from OABR

Figure 5 Example of Automotive Ethernet SMA Adapter (Molex to SMA) 
Available as custom order through Keysight.
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1 Introduction
Connection Using the Common Mode Emission Test Adapter

The Common Mode Emission test adapter is designed as outlined in OPEN Alliance Automotive 
Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test OABR_PMA_TX_07. This adapter was 
designed in line with the definitions of IEEE 100Base-T1 EMC Test Specifications for Transceivers, 
Appendix D, D.1 Test Conditions.

If you need a similar fixture, please contact your Keysight sales representative for more details.

Figure 6 Design of Recommended Common Mode Emission Test Fixture from OABR

Figure 7 Example of Common Mode Emission Test Adapter (Molex to SMA) 
Available as custom order through Keysight.
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Introduction 1
Starting the ECU Compliance Test Application

1 Ensure that the ECU’s PHY transmitter (DUT) is operating and set to desired test modes.

2 To start the ECU Compliance Test Application from the Infiniium oscilloscope’s main menu, 
select Analyze > Automated Test Apps > E6959A ECU Test App.

Figure 8 Launching the ECU Compliance Test Application
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 13



1 Introduction
The Compliance Test Application automatically sets frequency, etc. of the external instruments 
(oscilloscope, ENA, generators, etc.) if they are properly configured. Refer to “Configuring External 
Instruments” on page 40.

The tabs in the main pane show the steps you take in running the automated tests:

Figure 9 ECU Compliance Test Application Main Window

Requires Frequency 
Divider Board. See 
“Using the 
E6960-66600 
Frequency Divider 
Board” on page 45.

Refer to “Calibrating 
External Instruments” 
on page 42.

Refer to “Configuring 
External Instruments” 
on page 40.
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Introduction 1
Figure 10 Select Tests Tab with All Tests Selected

Displays test limits, 
test description, and 
IEEE specification 
reference for the 
selected test.

Tab Description

Set Up Lets you identify and set up the test environment.

Select Tests Lets you select the tests you want to run. After tests are run, status indicators show which tests have 
passed, failed, or have not run.

Configure Lets you configure test parameters (for example, oscilloscope channels used in test, number of 
averages, etc.).

Connect Shows you how to connect the oscilloscope to the device under test.

Run Tests Starts the automated tests. If the connections to the device under test need to be changed, the test 
pauses, shows how change the connection, and waits for you to confirm that the changes were made 
before continuing.

Automation Lets you construct scripts of commands to drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the thresholds 
at which marginal or critical warnings appear.

HTML Report Report Shows a compliance test report that can be printed. See “Viewing the Test Report” on page 33.
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 15



1 Introduction
Figure 11 Configure Tab for Transmitter Droop Tests

Figure 12 Connect Tab for Transmitter Droop Tests

The Configure Tab allows 
you to select different 
oscilloscope channels 
and measurement 
attributes.

For example, the signal 
input can be changed 
from a differential probe 
to two SMA cables.

Test connections are 
clearly identified 
including additional 
hardware and cables. 
When you make multiple 
tests where the 
connections must be 
changed, the software 
prompts you with 
appropriate connection 
diagrams.

Click Connection 
Completed before clicking 
Run Tests.
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2 Tests and Test Report
Transmitter Droop Tests

Test Setup

This test may be run using either a differential output or single-ended output from the transmitter 
(MDI). Refer to “General Test Setup” on page 9 for connection details.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX_01

[2] 100Base-T1, IEEE Std 802.3bwTM – 2015, Section 96.5.4.1

Transmitter Output Droop Positive Test Information

This test measures the positive output droop of the transmitter.

Reference [1] specifies the positive output droop of a compliant PHY. The positive droop measured 
with respect to the initial peak value after the zero crossing and the value 500 ns after the initial 
peak, shall be less than 45%.

The application triggers the Test Mode 1 signal on the rising edge and determines the time the 
positive peak occurred and the voltage at that specific instance. The application then measures the 
voltage 500 ns after the peak. The Droop is calculated as:

Droop = 100 x (Vd/Vpk) %

Where:

• Vd is the magnitude of the droop.

• Vpk is the initial peak after the zero crossing.

Typical Waveform

Use the software supplied with your transmitter PHY to control the Device Under 
Test.

Figure 13 Typical Positive Droop Test Waveform (using a pair of SMA cables)
18 Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation



Tests and Test Report 2
Transmitter Output Droop Negative Test Information

This test measures the negative output droop of the transmitter.

Reference [1] specifies the negative output droop of a compliant PHY. The negative droop 
measured with respect to the initial peak value after the zero crossing and the value 500 ns after 
the initial peak, shall be less than 45%.

The application triggers the Test Mode 1 signal on the falling edge and determines the time the 
negative peak occurred and the voltage at that specific instance. The application then measures 
the voltage 500 ns after the peak. The Droop is calculated as:

Droop = 100 x (Vd/Vpk) %

Where:

• Vd is the magnitude of the droop.

• Vpk is the initial peak after the zero crossing.

Typical Waveform

Figure 14 Typical Negative Droop Test Waveform (using a pair of SMA cables)
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 19



2 Tests and Test Report
Transmitter Timing Jitter in MASTER Mode

Test Setup

This test may be run using either a differential output or single-ended output from the transmitter 
(MDI). Refer to “General Test Setup” on page 9 for connection details.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX_02. 

[2] 100Base-T1, IEEE Std 802.3bwTM – 2015, Section 96.5.4.3

Transmitter Timing Jitter Test Information

This test measures the data time interval error of the test mode 2 signal at the MDI. The ideal 
reference data rate is selected automatically by the oscilloscope and compared to the original 
signal to determine the data time interval error.

Reference [1] and [2] specifies that when in test mode 2, the RMS (Root Mean Square) TIE value of 
the MDI output jitter, JTXOUT, relative to an unjittered reference shall be less than 50 ps.

Typical Waveform

Use the software supplied with your transmitter PHY to control the Device Under 
Test.

Figure 15 Typical MASTER TX Out Test Waveform (using a pair of SMA cables)
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Tests and Test Report 2
Transmit Clock Frequency

Test Setup

This test may be run using either a differential output or single-ended output from the transmitter 
(MDI). Alternatively, this test can also be run using the TX_TCLK. Refer to “General Test Setup” on 
page 9 for connection details.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX_03

[2] 100Base-T1, IEEE Std 802.3bwTM – 2015, Section 96.5.4.5

Transmit Clock Frequency Test Information

This test measures the frequency of the transmitter clock when the PHY is operating in MASTER 
mode.

Reference [1] and [2] specifies the symbol transmission rate of a compliant PHY. The symbol 
transmission rate of the MASTER PHY shall be within the range of 66 2/3 MHz ±100 ppm.

The Reference [1] and [2] specifies that Test Mode 2 shall transmit the data symbol sequence 
{+1, -1} repeatedly on the channel. The transmitter shall time the transmitted symbols from a 
symbol rate clock in the MASTER timing mode. The measured data rate of the Test Mode 2 signal is 
thus equal to the MASTER Transmit Clock Frequency of the PHY.

Typical Waveform

Use the software supplied with your transmitter PHY to control the Device Under 
Test.

Figure 16 Typical MASTER Clock Test Waveform (using a pair of SMA cables)
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 21



2 Tests and Test Report
Transmitter Power Spectral Density (PSD) Test

Test Setup

The Power Spectral Density (PSD) Test can be run using either a spectrum analyzer or an 
oscilloscope. When using the oscilloscope, “General Test Setup” on page 9 for testing using 
oscilloscope.

If you use the N9010B Signal Analyzer, convert the differential output to a single- ended output 
using a balun. Use the balun on the N5395C Ethernet Test Fixture as shown in Figure 17. This is a 
similar setup used when selecting single ended signaling to run the Power Spectral Density test; 
the only difference being the Signal Analyzer is replaced with an oscilloscope instead.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX04

[2] 100Base-T1, IEEE Std. 802.3bw-2015, Section 96.5.4.4

Figure 17 Power Spectral Density Test Using N9010B Signal Analyzer

Use the software supplied with your transmitter PHY to control the Device Under 
Test.
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Tests and Test Report 2
PSD Test Information

Reference [1] and [2] specifies that in Test Mode 5, the power spectral density (PSD) of the 
transmitter shall be between the upper and lower bounds specified in the table below. 

The upper and lower limits are piece-wise linear masks connecting points given in the table above. 
A lower PSD mask is provided to ensure the tolerances.

This test could be run using an external spectrum analyzer or the oscilloscope.

Typical Waveform

Frequency PSD Upper Bound (dBm/Hz)1

1 Settings: RBW=10 kHz, VBW=30 kHz, sweep time >1 min, RMS detector.

PSD Lower Bound (dBm/Hz)1

@1 MHz -63.3 -70.9

@20 MHz -64.8 -75.8

@40 MHz -68.5 -89.2

57 MHz–200 MHz -76.5 –

Figure 18 Typical Spectral Density Loss Test Waveform
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 23



2 Tests and Test Report
MDI Return Loss Test

Run the Management Data Input (MDI) Return Loss test with a vector network analyzer connected 
externally to the oscilloscope.

Test Setup

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX05

[2] 100Base-T1, IEEE Std. 802.3bw-2015, Section 96.8.2.1

Figure 19 Connection Setup for MDI Return Loss test

Where possible, it is recommended to use the Automotive Ethernet SMA 
Adapter described on page 11.
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Tests and Test Report 2
MDI Return Loss Test Information

This test can run with an external vector network analyzer. However, an ENA exported data file in 
the Touchstone or CITI format can also be used in place of the external vector network analyzer. 
The DUT must be set to SLAVE Mode of operation and not transmitting any test symbols.

Reference [1] and [2] specifies that the MDI return loss shall meet or exceed the following equation 
for all frequencies ranging from 1 MHz to 66 MHz (with 100 reference impedance) at all times.

Calibrate the ENA prior to running the tests. Set the ENA as follows: 

– Measurement: Return Loss Sdd11 
– Start Frequency: 1 MHz
– Stop Frequency: 1 GHz
– Sweep Type: Logarithmic
– Sweep Points: 1600
– Output Power: minimum -10 dBm
– Measurement Bandwidth: 100Hz
– Logic Port Impedance Differential Mode: 100 Ω
– Logic Port Impedance Common Mode: 25 Ω
– Turn Averaging On (at least 16 times)
– Smoothing function is deactivated

Frequency Return Loss (dB)

1 – 30 MHz 20

30 – 66 MHz 20 – 20*log(f/30)
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2 Tests and Test Report
MDI Mode Conversion Test

Run the Management Data Input (MDI) Mode Conversion test with a vector network analyzer 
connected externally to the oscilloscope.

Test Setup

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX06

[2] 100Base-T1, IEEE Std. 802.3bw-2015, Section 96.8.2.2

Figure 20 Connection Setup for MDI Mode Conversion test

Where possible, it is recommended to use the Automotive Ethernet SMA 
Adapter described on page 11.
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Tests and Test Report 2
MDI Mode Conversion Test Information

This test can run with an external vector network analyzer. However, an ENA exported data file in 
the Touchstone or CITI format can also be used in place of the external vector network analyzer. 
The DUT must be set to SLAVE Mode of operation and not transmitting any test symbols.

Reference [1] and [2] specifies that the MDI Mode Conversion shall meet or exceed the following 
equation for all frequencies ranging from 1 MHz to 200 MHz at all times.

Calibrate the ENA prior to running the tests. Set the ENA as follows: 

– Measurement: Mode Conversion Sdc11 
– Start Frequency: 1 MHz
– Stop Frequency: 1 GHz
– Sweep Type: Logarithmic
– Sweep Points: 1600
– Output Power: minimum -10 dBm
– Measurement Bandwidth: 100Hz
– Logic Port Impedance Differential Mode: 100 Ω
– Logic Port Impedance Common Mode: 25 Ω
– Turn Averaging On (at least 16 times)
– Smoothing function is deactivated

Frequency Return Loss (dB)

@1 MHz –60

@22 MHz –60

@100 MHz –47

@200 MHz –37
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2 Tests and Test Report
MDI Common Mode Emission Test

Test Setup

The MDI Common Mode Emission Test can be run using either a spectrum analyzer or an 
oscilloscope. 

When using the oscilloscope or N9010B Signal Analyzer, it is essential to use the Common Mode 
Emission Test adapter described on page 12 to condition and convert the signal to a single-ended 
output.

Any other test fixture/adapter can also be used but it must meet the conditions described in the 
IEEE 100Base-T1 EMC Test Specifications for Transceivers, Appendix D, D.1.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX07

[2] 100Base-T1, IEEE EMC Test Specification for Transceivers, Version 1, Appendix D

MDI Common Mode Emission Test Information

Reference [1] and [2] specifies that in Test Mode 5, the test shall be classified passed, if the value of 
the MDI common mode emission (CME) of the transmitter, fulfills the limit specified in the table 
below.

Figure 21 Common Mode Emission Test Using N9010B Signal Analyzer

Use the software supplied with your transmitter PHY to control the Device Under 
Test.

Frequency CME Limit (dBµV)

@2 MHz  24

@70 MHz  24
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Tests and Test Report 2
This test could be run using an external spectrum analyzer or the oscilloscope. Recommended 
settings for CME measurement at MDI are shown below.

Table 1 Settings for Measurement Device for CME Test

Measuring Equipment Spectrum Analyzer EMI Measuring Receiver Oscilloscope with Spectrum 
Analyzer Functionality

Measurement unit dBμV

Detector Peak –

Frequency range 1 MHz to 200 MHz

Resolution bandwidth (RBW) 10 kHz 9 kHz 10 kHz

Video bandwidth (VBW) > 3 x RBW – –

Number of passes 10 (max hold) 1 in minimum 10 (max hold)

Measurement time per step – ≥ 1 ms –

Frequency sweep time ≥ 20 s – –

Frequency step width – ≤ 0.4 x RBW –

Time Base – – 50 μs/div 500 kS
in minimum 1 GSa/s

Amplitude – – ≤ 2 mV/div

Input DC 50 Ω 
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2 Tests and Test Report
Transmitter Distortion Test

Test Setup

Sections 1 and 11 of the N5395C Ethernet Test Fixture are used in this test. Automotive Ethernet 
SMA Adapter (page 11) or an equivalent adapter can be used to replace Section 1 of the N5395C 
Ethernet Test Fixture.

A disturbing signal source is required to test for compliance. There is an option to test without a 
disturbing signal source, but the test result is not applicable for compliance. The test accepts only 
a differential signal.

When using a supported function generator, there is an automatic calibration process to calibrate 
the function generators. If an unsupported model is used, the user will have to manually calibrate 
the function generators.

Supported Function Generators Number Required Notes

Keysight 33250A 2 Keysight 82357B USB/GPIB interface and one additional GPIB 
cable required.

Keysight 33612A 1 LAN Cable required.

Keysight 81150A 1 LAN Cable required (2- channel, orderable through E6961A 
Compliance Test Solution).

Figure 22 Transmitter Distortion Test Connection Using two Keysight 33250A Function Generators
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Tests and Test Report 2
Figure 23 Connection for Transmitter Distortion Test Using Keysight 33612A Function Generator

Figure 24 Connection for Transmitter Distortion Test Using Keysight 81150A Function Generator
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2 Tests and Test Report
Using the Optional E6961A Frequency Divider Board

If you want to use the optional Frequency Divider Board to provide a stable 10 MHz reference 
clock, refer to “Using the E6960-66600 Frequency Divider Board” on page 45 for detailed 
information.

Specification References

[1] OPEN Alliance Automotive Ethernet ECU Test Specification, v2.0, Section 2.2.2, Test 
OABR_PMA_TX08

[2] 100Base-T1, IEEE Std. 802.3bw-2015, Section 96.5.4.2

Transmitter Distortion Test Information

When operating in Test Mode 4 and capturing the waveform using Section 11 of the fixture, the 
peak distortion values, measured at a minimum of 10 equally-spaced phases of a single symbol 
period, shall be less than 15 mV.

Reference [1] and [2] specify that the peak distortion is determined by sampling the differential 
signal output with the symbol rate clock at an arbitrary phase and processing a block of any 2047 
consecutive samples with MATLAB code in reference [1] and [2].

A software high pass filter is applied to the sampled signal before post-processing.

Alternatively, this test can also be run without the disturbing signal, but the result cannot be used 
to determine compliance.

Typical Waveform

If using the Frequency Divider, connect the 10 MHz output(s) of the divider to 
the 10 MHz Ref In Input of the oscilloscope and function generator for clock 
synchronization.

Figure 25 Typical Distortion Test Waveform (using a pair of SMA cables)
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Tests and Test Report 2
Viewing the Test Report

After running any or all of the Compliance tests, the Results tab shows which tests passed and 
details about the individual tests. For test result details, select any one of the tests form the top 
pane; the test details are shown below. In Figure 26 below, the Transmitter Power Spectral Density 
test is selected and the test results, with waveform, is shown below. 

Figure 27 on page 34 shows a portion of a typical HTML Report. Below this segment are waveforms 
and more test data.

Figure 26 Typical Results Tab
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2 Tests and Test Report
Figure 27 Top Portion of a Typical HTML Report
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3 Appendix
Reference Documents

OPEN Alliance / ECU Specifications: 
www.opensig.org or 
www.ieee802.org 

Keysight’s Automotive Ethernet Test Solutions Web Page: 
www.keysight.com/find/E6959A 

E6961A Automotive Ethernet TX Compliance Solution Web Page: 
www.keysight.com/find/E6961A 

Other Keysight Automotive Ethernet Applications and Software

• E6960A 1000Base-T1 TX Compliance Application: 
www.keysight.com/find/E6960A 

• E6961A Automotive Ethernet TX Compliance Solution:
www.keysight.com/find/E6961A 

• E6962A Automotive Ethernet RX Compliance Solution – includes E6962A BroadR-Reach RX 
Compliance Application (100Base-T1 compliant) software:
www.keysight.com/find/E6962A 

• E6963A BroadR-Reach Automotive Ethernet Link Segment Compliance Solution – includes 
E6963A BroadR-Reach Link Segment Compliance Application (100Base-T1 compliant) 
software:
www.keysight.com/find/E6963A 

• N6467B BroadR-Reach Transmit Compliance Application Software (100Base-T1 compliant):
www.keysight.com/find/N6467B 

• N8847A Protocol Triggering and Decoder Software (100Base-T1 compliant)
www.keysight.com/find/N8847A 
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Appendix 3
Setting Up the N5395C Ethernet Transmitter Test Fixture

Keysight’s N5395C Ethernet 10/100/1G Transmitter Electrical Test Fixture includes a main test 
fixture board (N5392-66402), a short RJ45 interconnect cable (N5392-61601), and a small Return 
Loss impedance calibration board (N5392-66401).

Keysight’s N5395C Ethernet Test Fixture is recommended for the compliance of Test Mode 4. A 
different, comparable fixture may be used, but is not guaranteed to produce the same result.

Notice that the main Test Fixture board is divided into eight sections plus an area to store jumpers. 
Not all sections are used in this demo/evaluation. Refer to Figure 28.

Compliance Test 
Board Section

Description Compliance Test Mode

1 Differential Return Loss used for RJ45 devices Conversion from RJ45 to SMA

2 Load & Probes Not Used

3 100BT Jitter Not Used

4 Common Mode Output Voltage Not Used

6 10BT w/o TP Model Not Used

7 10BT with TP Model Not Used

10 Balun Power Spectrum Density Test

11 Disturbance/Distortion Transmitter Distortion Test

Figure 28 N5395C Ethernet Electrical Transmitter Test Fixture
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3 Appendix
Jumper Settings

Figure 29 and Table 2 on page 39 show the jumper positions for the Ethernet Test Fixture 
Section 11 applicable for various frequencies.

Figure 29 Section 11 on the Ethernet Test Fixture
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Appendix 3
Table 2 Jumper Locations for Ethernet Test Fixture (Section 11 on Test Fixture)

Filter Bandwidth Jumper Location

25 MHz

35 MHz

102 MHz
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3 Appendix
Configuring External Instruments

For each test, the DSOS254A Infiniium oscilloscope automatically configures any external 
instruments (AWG, E5071C ENA, and N9010B EXA Signal Analyzer) as required for the test. In 
order to do this, however, the oscilloscope must know the SCPI address of each instrument. The 
External Instruments Status indicator is red if the instruments are not properly configured.

1 On the ECU Compliance Test Application’s Set Up tab, click the Configure button.

The instruments must be connected to the oscilloscope prior to configuring 
them. This is generally through a USB connection.

Note that the 33250A AWGs require an 82357B USB/GPIB interface. You must 
configure the Master and Slave 33250A AWGs separately.

Figure 30 ECU Compliance Test Application Set Up Tab
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Appendix 3
This opens the External Instruments List dialog box. 

2 Select the AWG used in your system. For the E6959A Solution, any of the AWG can be selected. 
For example, Fg81150/60.

3 Provide the SICL address:

• If you know the SICL address (you can use Keysight IO Libraries Suite Connection Expert 
utility to obtain the SICL address) enter it in the SICL Address field. 

• If you do not know the SICL address, click the Find button and the Compliance Test 
Application will attempt to locate and identify the AWG.

4 Click the Update button.

5 Repeat steps 2 to 4 for the E5071C ENA and the N9010B EXA Spectrum (or Signal) Analyzer. 

6 When you are finished, click the Done button to return to the Set Up tab.

7 The External Instruments Status indicator turns green to indicate that all external instruments 
have been properly configured.

Figure 31 External Instruments List
Keysight E6959A ECU Compliance Test App User Guide & Methods of Implementation 41



3 Appendix
Calibrating External Instruments

All instruments must be calibrated prior to running the compliance tests. The Compliance Test 
Application guides you in calibrating the AWG and the ENA.

Calibrating the AWG

Before running disturbing signal tests, the AWG(s) must be calibrated. Connect the equipment 
depending on the AWG used:

• When using two 33250A AWGs, see Figure 22 on page 30.

• When using a 33612A AWG, see Figure 23 on page 31.

• When using an 81150A AWG, see Figure 24 on page 31.

The AWG Disturbing Signal Source must be configured before attempting to 
calibrate it. If the system is not physically configured to perform the calibration, 
the application prompts you to change the physical configuration. Refer to 
“Configuring External Instruments” on page 40.

Instead of connecting SMA to SMA cables on the N5393C Evaluation Board, 
connect 50 Ω terminators to the two DUT SMA connectors on the Evaluation 
Board. This is shown in Figure 32.

Figure 32 AWG Calibration Setup for the Disturbing Signal Source
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Appendix 3
Performing the AWG Calibration for the Disturbing Signal Source

1 On the ECU Compliance Test Application’s Set Up tab, click the Calibrate Sources button.

This opens the Calibrate Disturbing Signal dialog box for the selected AWG. 

2 With the appropriate AWG Address set and the correct oscilloscope channels selected, click 
the Calibrate button to start the calibration process.

3 When the software finishes the calibration, click the Done button to return to the Set Up tab.

Refer to the E6959A online help for a more detailed explanation.

Figure 33 ECU Compliance Test Application Set Up Tab
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3 Appendix
Calibrating the ENA

Before using the ENA, it must be calibrated using the N4431B Ecal Kit. See Figure 34 below for the 
connection diagram. Calibrate the ENA using the instructions in the ENA’s user guide.

1 Connect the USB port on the Ecal module with the USB port on the E5071C via a USB cable. 
This connection may be done while the E5071C’s power is on.

2 Allow the Ecal module to warm up for 15 minutes until the module indicator changes from WAIT 
to READY.

3 Connect port A and port B on the Ecal module to the ENA’s test ports (using SMA cables) to be 
calibrated. Use the N-type (M) to SMA Adapter for easy connection of SMA cables.

4 Press Channel Next/Channel Prev keys to select the channel for which you want to perform the 
calibration.

5 Click Ecal.

6 Click 2 Port Ecal. 

• When using a 2-port E5071C, pressing this key performs a 2-port Ecal.

• When using a 3-port or 4-port E5071C, click one of the softkeys to start a full 2-port 
calibration.

7 The following is a list of setup requirements prior to running the calibration routine.

• Set Measurement to either Sdd11 or Sdc11 depending on test.

• Set Start to 1 MHz.

• Set Stop to 1 GHz.

• Set Format to Log Mag.

• Set Sweep Type to Logarithmic.

• Set Points to 1600.

• Set Output Power to 0 dBm.

• Set Measurement Bandwidth to 100 Hz.

Figure 34 ENA Calibration Setup
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Appendix 3
Using the E6960-66600 Frequency Divider Board

Keysight’s E6960-66600 Frequency Divider Board produces two identical clock signal outputs 
(10 MHz) that are phase locked to the input clock. This Frequency Divider Board is recommended 
for Transmitter Distortion Test.

Static-safe Handling Procedures

Electrostatic discharge (ESD) can damage or 
destroy electronic components. Use a static-safe 
work station to work on electronic assemblies. 
This figure shows a static-safe work station using 
two types of ESD protection:

• Conductive table-mat and wrist-strap 
combination

• Conductive floor-mat and heel-strap 
combination

Both types, when used together, provide a 
significant level of ESD protection. Of the two, 
only the table-mat and wrist-strap combination 
provides adequate ESD protection when used 
alone. To ensure user safety, the static-safe 
accessories must provide at least 1 MΩ of isolation from ground.

Observe appropriate ESD precautions before connecting and disconnecting cables and changing 
the positions of jumpers and switches.

To use the divider board, check the Use 10MHz Ref Clock on the ECU Compliance Test Application 
Set Up tab.

Figure 35 Keysight E6960-66600 Frequency Divider Board
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3 Appendix
Configure the test setup as shown below.

Figure 36 Select Use 10MHz Ref Clock on Set Up tab

Figure 37 Test Setup for 10 MHz Frequency Reference
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Appendix 3
Frequency Divider Board Test Setup

1 Connect CH1 SMA connector to the Device Under Test (DUT).

2 Use BNC to BNC cables to connect both J400 and J403 BNC connectors to the oscilloscope 
and the AWG 10 MHz In.

3 Select 4.2 Vpp output voltage by shorting Pin1 and Pin2 of J100 with jumper.

4 Select Normal Running mode by switching switch A1 to OFF.

5 Select Frequency Tracking mode by switching switch A2 to OFF.

6 Select CH1 as input by switching switch A6 to OFF.

7 Select Targeted 25 MHz input by switching switch B2 to ON.

8 Power on the board by connecting a power source to the USB connector or to the DC power 
jack. (4.5V to 5.5V @450mA).

At power on:
– the Power LED PWR (D303) should light up as GREEN
– the LED A (D302) should light up as GREEN
– the LED B (D304) should light up as GREEN

Connector Description 

This section describes the various user components on the E6960-66600. 

Component Description

USB type-B / DC Jack Provides power to the fixture. Either the USB port or the 2.5 mm, center positive DC Power input 
jack may be used. The USB jack is not used for any other purpose. Input voltage is required to be 
within +4.5V to +5.5V @500mA. Any voltage that is out of specification will trigger a warning on 
the Power LED. 

SMA Provides an interface to feed the input signal into the test fixture. CH1 connector is 50 Ω 
terminated and CH2 connector is 10k Ω terminated. 

BNC Both J400 and J403 produce a separate output clock signal. The signals are back-terminated by 
50 Ω. 

Jumpers Provides user the option to modify the test fixture circuitry. 

J100 This jumper controls the output signal amplitude: 
4.2Vpp: Connect pin 1 and pin 2 
3.3Vpp: Connect pin 2 and pin 3 
3.0Vpp: Connect pin 3 and pin 4 

J300 & J302 This jumper allows user to probe the channel 1 and channel 2 inputs respectively 

J401 This jumper shorts both outputs together. 

J402 Parking location for unused jumpers. 
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3 Appendix
DIP Switch Description 

Switch A 

Switch A sets the Fixture operating mode.

Switch B 

Switch B sets the frequency divider to the relevant setting.

Switches Position Operating mode Comment 

A1 off Normal running mode Normal operating mode 

on Sleep mode Change made to any of the switches are ignored 

A2 off Frequency Tracking Mode Output frequency track to input frequency 

on Lock Frequency Mode Output clock is phase lock to input clock 

A3 off NA NA 

on NA NA 

A4 off NA NA 

on NA NA 

A5 off NA NA 

on NA NA 

A6 off Select CH1 as input NA 

on Select CH2 as input NA 

A7 off NA NA 

on NA NA 

A8 off NA NA 

on NA NA 

Divider Comment 

B8 B7 B6 B5 B4 B3 B2 B1 To obtain 10 MHz output:

off off off off off off off off Not valid (def) Free Run Mode 

off off off off off off off on Div 1 Targeted 10 MHz input clock 

off off off off off off on off Div 5/2 Targeted 25 MHz input clock 

off off off off off on off off Div 20/3 Targeted 66.67 MHz input clock 

off off off off on off off off Div 25/2 Targeted 125 MHz input clock 

off off off on off off off off Div 75 Targeted 750 MHz input clock 
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Appendix 3
LED Description 

Other combinations are not valid. if no valid switch setting is detected, the LED 
will flash, indicating invalid switch B configuration. After reset, if no valid 
position is detected, the board uses the “Free Run Mode” which generates an 
accurate 10 MHz signal. 

Table 3 Power LED

Green Red 

Input voltage below 4.5V ON Flash 1 Hz 

Input voltage below 3.6V ON Flash 2 Hz 

Input voltage above 5.5V ON ON 

Table 4 LED A

Green Red 

Input signal locked (Normal condition) ON OFF 

Lost of Lock Flash 1 Hz OFF 

Lost of Signal OFF Flash 1 Hz 

Lost of 48 MHz reference OFF ON 

Table 5 LED B

Green Red 

Valid switch B configuration (Normal condition) ON OFF 

Invalid switch B configuration Flash 1 Hz OFF 

Missing input signal/ input signal out of range/ 
Warning. See LED A for list of warning.

N/A ON 
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